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RealCare Baby® 4 Control Center Software

Help Guide

General Information
This section contains information about the Control Center Software program, 
how to start using the software with RealCare® Babies, how to get assistance 
using the software, and a list of terms that are used by the software. 

The RealCare Control Center software is intended for wireless control of one 
or more RealCare® Baby infant simulators (referred to as Babies in this guide). 
It manages parenting simulation programming, displays Baby status, and 
permits student report download and storage. The Control Center Software 
communicates with RealCare® Baby 3 and 4.

Program Functions 
Control Center software contains all the tools necessary to program Babies for 
infant care simulations, download student reports, and perform maintenance 
on Babies. The software assigns the class name, Baby name, student name, Baby 
gender, start and stop times for the simulation, the simulation care level (easy, 
medium, or hard), and preset quiet times when Babies will not cry for care. The 
software downloads and stores simulation reports in a database. 
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Useful Terms
•	 About – Shows the version number and manufacture date of your                                  

Control Center software

•	 Active – A Baby that is actively engaged in an infant care simulation

•	 Add – Screen that allows adding Babies to the All Babies list to establish                  
wireless communication

•	 Add a Baby – Establishes wireless communication between Control Center and the 
Baby electronics module

•	 All Babies Screen – The default screen displayed when the Control Center software 
starts; you can see all the Babies connected to the software

•	 Available – Status when Baby is not engaged or scheduled for a simulation

•	 Baby ID – An identification number assigned to an infant simulator

•	 Baby List – Babies contained in the Baby database; displayed on the                                  
All Babies screen

•	 Car Seat – RealCare Baby tracks the length of time it has been in a car seat when 
used with car seat detection tags

•	 Caregiver – Participant assigned to an infant care simulation

•	 Caregiver Wristband – Wristband containing a unique identification disc worn by 
the person caring for Baby

•	 Care Level – The frequency and length of Baby care requests during the simulation 
(easy, medium, hard, or random)

•	 Charging Station – DC charger for charging five infant simulators at a time.

•	 Child Care – An option that a facilitator can activate on demand when the 
participant cannot care for Baby; Baby does not request any care or respond to 
mishandling when this option is active

•	 Class – The folder name for simulation reports

•	 Clipboard – During the export process, the software copies a graphic file of the 
active report to a virtual clipboard for pasting into an email message or word 
processing document

•	 Clothing – Baby can tell what article of clothing it wears and for how long

•	 Database – A list of Babies that have been added to the Control Center software

•	 Demo – Demonstrates each of Baby’s care events individually                                    
(feeding, burping, rocking, etc.)

•	 Electronics Module – Circuit board assembly with rechargeable batteries that 
communicates with Control Center and records simulation data

•	 End Simulation – Option that stops the simulation and downloads the final report
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•	 Gender – Sex assigned to an infant simulator

•	 Get Report – A Control Center command that allows the user to retrieve and view a 
simulation report while the simulation is running

•	 Host Computer – The computer containing the Control Center software Infant
•	 Care Schedule – Choose from schedules 1-30 (1-15 are for RealCare Baby 3, 16-30 

are for RealCare Baby 4)

•	 Mishandle – When the participant does not support Baby’s head, roughly handles 
Baby, places Baby in a wrong position, exposes Baby to a loud noise, or shakes Baby

•	 Missed Care – When Baby requires care and is not cared for within two minutes

•	 Page – Control Center command intended to locate (i.e. “page”) a specific Baby by 
prompting the Baby to coo

•	 Pending – Baby changing from one status to another

•	 Print Report – Sends a simulation report to a printer

•	 Program Baby – Assigns Baby’s characteristics, simulation times, and care level

•	 Proper Care – When a participant provides the correct care to Baby

•	 Ready – Status when Baby is programmed for a simulation that has not started yet

•	 Report Due – Status when Baby has finished a simulation but has not downloaded 
the final report

•	 Quiet Times – Preset periods programmed during the infant care simulation when 
Baby does not require care, but responds to mishandles

•	 Schedule Order – The mix of care levels assigned to an infant care simulation that 
can be set to easy, medium, or hard difficulty

•	 Single Charger– DC charger for a single infant simulator

•	 Start – The programmed simulation starting day and time

•	 Stop – The programmed simulation stop day and time

•	 Student ID – Identification number disc given to each participant during a 
simulation; primary caregiver is ID1 and secondary caregiver is ID2

•	 Student Name – The name of the participant assigned to an infant simulator

•	 Talking – When awake, Baby tracks how much users talk to it

•	 Temperature – Baby can report temperature in either Fahrenheit or Celsius; the 
temperature reported is internal to Baby and not external temperature

•	 Troubleshooting – Control Center diagnostics that allow the user to verify that 
Baby’s sensors are operating normally

•	 Tummy Time – Baby tracks how much time it spends on its tummy

•	 View Report – View a simulation report on your computer screen
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Add Baby Screen Overview 
When Control Center software starts, it displays the All Babies screen. The 
Baby list shows all Babies in the database. When run for the first time, the 
database is empty, and Babies must be added. 

a.	 Battery level displays. Red indicates a very low charge; Baby should be 
charged immediately. Green indicates an adequate charge level. 

b.	 A green communication icon in the Comm (Communication) 
column indicates communication with the Baby. A red 
communication icon indicates that communication                        
has been lost.

c.	 The Status column shows if the Baby is Pending, Added, or 
NOT Added. Baby’s yellow LED will remain illuminated when pending. 
After several seconds, Baby’s status on the Add Baby screen changes from 
Pending to Added and the communication icon turns green. Baby now 
belongs to this Control Center software. 

NOTE: If a Baby is not added to the Baby list for some reason, the Comm icon 
changes to red and the status changes to NOT Added. When this happens, 
repeat the Add Baby Instructions on the Add Baby screen.

Getting Started
Adding Babies
When the Control Center software starts, it displays the All Babies screen. The 
list shows all Babies connected to the software. When you launch the Control 
Center software for the first time, the database is empty, and Babies must be 
added. Additional Babies can be added at any time. 

1.	 Click Add in the sidebar. The Add Baby 
screen displays.

2.	 Follow the Add Baby Instructions                      
on the screen.

3.	 Click Back to return to the All Babies screen.
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Control Center Software Tour
Introduction
Control Center software contains all of the necessary tools to program 
Babies, download simulation reports, and perform maintenance. The 
software is used to:

•	 Assign Baby name and identification numbers
•	 Assign student name and identification numbers
•	 Assign Baby gender
•	 Assign start and stop times for the infant care simulation
•	 Assign care level: easy, medium, hard, or random
•	 Assign preset quiet times, i.e. time periods when Babies will                                

not request care
•	 Download simulation reports to a report database
•	 Terminate a simulation before the scheduled stop time
•	 Activate the child care option (a period when Baby does not require care)
•	 Perform maintenance 

Babies Menu
Add: Display the Add Babies screen to 
allow adding new Babies to the database. 
See Adding Babies section of the guide for 
further details.

All: Displays the entire database list with 
Baby ID, student name, simulation start 
date, simulation stop date, battery level, and 
communication status.

Available: Displays a list of Babies available 
for a new simulation.

Active: Displays a list of Babies that are engaged in or programmed                       
for a simulation.

Report Due: Displays a list of Babies that have completed a simulation            
and have a final report ready to download.
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Reports Menu
Reports: Displays the entire existing list of 
report folders. See the Report List section 
for more details.

Add: Allows users to create a new 
report folder in the report database. 
See the Adding a Report Folder section                            
for more details.

Pencil Icon: Displays the report folder 
screen, which permits renaming, emptying, and deleting report folders. See 
the Editing Report Folders section for more details.

Trash: A folder that contains deleted reports. See the Deleting a Folder 
section for more details.

No Class: A default folder that cannot be renamed or deleted.

All Babies Screen
The All Babies screen displays all Babies connected to the software and is the 
default screen that displays when Control Center software is started. The first 
time you use the software, the Baby list will be empty. See the Adding Babies 
section of this guide for more details.

All Babies Columns
Checkbox: Click the checkbox to select the Baby. A check will display in the 
box. Click again to de-select the Baby. Select or de-select all Babies on the 
list by clicking on the X at the top of the checkbox column.

Baby ID: Column that displays the unique Baby identification number. This 
ID is preset but can be changed on the Program Babies screen. See the 
Assigning Baby ID section for more details.

Student: Column that displays the student name assigned to the Baby on 
the Program Baby screen. This only appears for Active or Report Due Babies. 
See the Assigning Student and Baby Names section for more details.
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Start: Column that displays the infant care simulation start day and time. 
This only appears for Active, Ready, Child Care, or Report Due Babies. See the 
Starting a Simulation section of this guide for more details.

Stop: Column that displays the infant care simulation stop day and time. 
This only appears for Active, Ready, Child Care, or Report Due Babies. See the 
Starting a Simulation section of this guide for more details.

Battery: Column that displays the charge level of the Baby battery module. 
Red battery indicates a very low charge. Babies with this battery condition 
need to be charged immediately. Amber battery indicates a charge less than 
40%. Green battery indicates an adequate charge level.

Comm: Communication column that displays the simulator communication 
condition. A green icon indicates that the simulator has communication with 
Control Center. A red icon indicates no communication.

Status: Column that displays the current status of each Baby – Available 
(can be programmed for a simulation), Active (in a simulation), Ready 
(programmed for a simulation that has not started yet), and Report Due (has 
completed a simulation but has not downloaded the simulation report).

All Babies Menu Bar continues on the next page –>

Demo: Displays the demonstration screen to allow demonstration or 
practice of each of Baby’s features individually or as a pre-selected group. 
See the Baby Demonstration section of this guide for more details.

Program Baby: Displays the program screen to assign the class name, Baby 
name, student name, Student ID numbers, gender, simulation start and 
stop times, care level schedule, and quiet time schedule. See the Starting a 
Simulation section of this guide for more details.

Birth Certificate: Displays a screen to print one or more Baby birth 
certificates. See the Baby Birth Certificates section of this guide                               
for more details.

Get Report: Downloads a report from a Baby that has a simulation                             
in progress.

All Babies Menu Bar



10

REALCARE BABY® 4 

Program Toolbar
The toolbar allows access to features that support Control Center software 
operation and technical support.

File Menu
Pod Tool: A tool for Product Support use. It should only be used with 
Product Support supervision.

Comm Log: A log of all communication between Control Center and Babies. 
It is primarily used by Product Support.

Beacons: A tool to determine if Student IDs and Toys are working correctly. 
It contains all nearby IDs and Toys that Control Center detects. It can also be 
used to detect nearby RealCare Baby 4 simulators by selecting the "Include 
Babies" checkbox.

Commands: Allows you to reset Baby’s batteries and print QR codes for 
connecting Babies to the RealCare Baby Guide app.

Export: Copies a selected report to the computer’s virtual clipboard for 
pasting into an image editor, a word processing document, or an email.

Quit: Click to close the Control Center software. Database is saved to the 
host computer.

Edit Menu
Preferences: Permits use of an alternative Baby communication                    
channel if needed. Switches the communication log on or off and allows you 
to select Celsius or Fahrenheit temperature display.

Stop: Ends the simulation before the programmed stop time and downloads 
a report. See the Stopping Simulation section of this guide for more details.

Maintenance: Displays the Maintenance screen to locate a Baby and 
perform troubleshooting functions. See the Maintenance section of this 
guide for more details.

Child Care: Displays the Child Care screen to start or stop child care. See the 
Child Care section of this guide for more details.

Delete Baby: Removal of selected Babies from the software. See the 
Deleting a Baby section of this guide for more details.
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Help Menu
Help: Displays the RealCare Baby Support Page

Tutorial: View step-by-step starter instructions

Check for Updates: Download the latest software updates

About: Display the Control Center version number 

View Baby Information Screen
The View Baby information screen allows users to display the current or most 
recent simulation information for that Baby. To open this screen, click on a Baby 
ID from the All Babies screen. Click Back to return to the All Babies screen.

Baby Demonstration
The Demonstration screen allows practice or demonstration of all Baby’s 
features. Baby demonstration is available when the Baby’s status is Available. 

The Demonstration screen for Baby is not available when Baby is 
Active, Ready, or in Child Care (engaged in or programmed for an active                             
infant care simulation).

Navigating to the                            
Demonstration Screen
On the Available Babies screen or All Babies screen, click the 
checkbox for the Baby you want to demo and click Demo. The 
Demonstration screen displays.

Demonstration Presets
Choose any of these preset demonstration options if you do not want to 
select specific event durations and order of demonstration. 

Demonstration Presets continues on the next page –>

Delete Babies: Permits the removal of selected Babies from the database. 
See the Deleting a Baby section of this guide for more details.
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Clicking Preset 1, Preset 2, Feed, Burp, Diaper, or Rock loads preset 
settings for a demonstration. Start the preset demonstration by clicking 
Start Demo.

Preset 1: Mix of events that include Coo, Feed, Burp, Diaper, Cough, and 
Rock. Check the box by Play if you want that included. Each event will 
demonstrate one time. Events play in order and last for 60 seconds with 30 
seconds of quiet between each event. 

Preset 2: Mix of events that include Feed, Burp, Diaper, and Rock. Events 
will demonstrate in a random order continuously. Check the box by Play if 
you want that included. Each event lasts 2 minutes with 30 seconds of quiet 
between each event. 

Feed: Feed event, which lasts 30 seconds. 

Burp: Burp event, which lasts 30 seconds. 

Diaper: Diaper event, which lasts 30 seconds. 

Rock: Rock event, which lasts 30 seconds. 

REALCARE BABY® 4 

Demoing Baby 
1.	 On the Demonstration screen, check the box for the Baby you                            

want to demo. 

2.	 Check the boxes for one or more of the Coo, Feed, Burp, Diaper, Cough, 
Rock, or Play events or choose one of the preset demonstrations.

3.	 Set the Event duration and Quiet between events times in seconds by 
clicking the up or down arrows.

4.	 Click This order or Random order and Play Once or Continuous. 

5.	 Click Start Demo to start the demo and Stop Demo to end it.
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Starting a Simulation
The Program Baby screen allows you to assign the class name, Baby name, 
student name, ID1 and ID2 numbers, Baby gender, simulation start and stop 
times, simulation care level (easy, medium, hard, custom, or random), and 
Quiet Times when Babies will not require care.

Program Baby Screen
Navigating to the Program                   
Baby Screen
1.	 On the All Babies screen, click the 

checkboxes for each Baby you want to 
program. We recommend programming a 
maximum of 5 Babies at a time. 

2.	 Click Program Baby. The Program Baby 
screen displays, allowing you to assign 
data to the first Baby on the list.

Programming Babies
1.	 Click Previous or Next to switch between the Babies you want to program.

2.	 Optional: Click the Class 
dropdown and select New 
Class. Type your class name 
in the popup that displays. The class name can be up to 20 letters, numbers, 
and spaces. Click OK to save the class name.

NOTE: When Baby completes a simulation, the simulation report will appear in 
the reports folder with the class name you selected.

3.	 Click the pencil icon below ID1 or ID2 to assign a Student ID and enter the 
ID number on the bottom of the ID disc in the popup that appears.  

4.	 Click OK to save the ID number. 

5.	 Optional: Click the Student text field and 
enter the student’s name.

6.	 Optional: Click the Baby text field and 
enter the Baby’s name.

Programming Babies continues on the next page –>



14

7.	 Optional: Click the pencil icon by Baby ID to change the Baby’s ID. Type the 
Baby’s new ID in the popup that displays. Click OK to save the ID.

8.	 Optional: Click the pencil icon by Gender to change the Baby’s gender. 
Select the Baby’s gender from the list in the Edit Gender popup that 
appears. A new Baby's gender defaults to none.

9.	 Use the Start and Stop dropdown arrows to program the simulation start 
and stop times. A simulation can be scheduled to start up to seven days in 
advance and can last from one hour to two days. 

REALCARE BABY® 4 

10.	Select a specific schedule order by clicking the Schedule Order dropdown 
arrows and choosing your desired number or select a random schedule by 
clicking Schedule Helper. 

NOTE: Baby will advance 
to the next schedule at 6 
a.m. daily. See the Selecting 
Schedule Orders section of this guide for more details.

11.	Optional: Click the Quiet Times dropdown arrows to schedule periods 
during the simulation when Baby will not require care but will respond to 
mishandling. You can select up to three Quiet Times during a simulation 
with each Quiet Time lasting for up to 12 hours. Click Reset to reset each

NOTE: The total scheduled Quiet Time displays in an information window. It is 
possible to schedule quiet time periods that overlap. Overlapping quiet time 
periods and Quiet Times scheduled before the simulation Start Time and after 
the simulation Stop Time are not included in the total Quiet Time. 

12.	Click Done to display the Program Baby                                      
– Summary screen. 
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Selecting Schedule Orders
Selecting specific schedule orders for each day of the simulation is a separate 
option from selecting an easy, medium, or hard mix of schedules for all days. 
To learn how to select an easy, medium, or hard mix of schedules. 

You must select a schedule order for the simulation before it starts. There 
are 30 real infant schedules you can choose from, and they are ranked as 
easy, medium, or hard. A random mix is also available. Schedules 1-15 are for 
RealCare Baby 3. Schedules 16-30 are for RealCare Baby 4. The care level or 
specific schedule numbers are scheduled for 5 days. If the simulation lasts 
more than 5 days, the schedules will repeat from the beginning. The schedule 
changes at 6 a.m.

Choosing Your Own Schedule Order
Each schedule order field represents one day of the simulation. Click the 
Schedule Order dropdown arrow and select the schedule number you want.

Easy Care Schedules: 9, 11, 12, 13, 15, 24, 26, 27, 28, 30

Medium Care Schedules: 2, 3, 7, 10, 14, 17, 18, 22, 25, 29

Hard Care Schedules: 1, 4, 5, 6, 8, 16, 19, 20, 21, 23

Saving Program Data
TIP: Plug Babies into their charger for faster communication.

1.	 Review the data displayed on the Program Baby – Summary screen.

2.	 To make changes to the data before saving, click Back, make any changes 
needed, and click Done again.

3.	 If the data is correct, click Send to Baby(s). This option will now deactivate. 

The program data is sent and Baby chimes when it receives the data. Baby’s 
status changes from Available to Pending briefly, then to Ready or Active 
for a successful save. At the simulation’s scheduled Start Time, Baby’s status 
will change from Ready to Active. 

Baby’s status may show as Fail, which means 
communication with Baby was interrupted 
and the program data was not saved. If 
that happens, the Send to Baby(s) option re-activates. Click the button 
again to re-transmit the program data. If this happens frequently, see the 
Connectivity and Communication Troubleshooting section of this guide.



16

Schedule Helper
The Schedule Helper lets you choose an easy, medium, hard, or random mix of 
infant schedules.

1.	 Click Schedule Helper to open the Schedule Helper popup.

2.	 Click Easy Mix, Medium Mix, Hard Mix, or Random to select                                   
a schedule mix.

3.	 Optional: If you do not like the mix, you can click the dropdown arrows for 
the day you want to switch the schedule for that day.

4.	 Click OK to save the selected schedule mix and close the popup.

REALCARE BABY® 4 

During the Simulation
Child Care
You can activate Child Care on demand when the student cannot care 
for Baby. Baby does not request any care when the Child Care option is 
active. The Child Care screen allows the user to start and stop Child Care on 
demand. To start and stop Child Care, Baby must be engaged in an active 
simulation. Babies will also need to be within communication range.

Starting and Stopping Child Care
1.	 On the Active Babies screen, click the Baby’s checkbox.

2.	 Click Child Care. The Child Care screen displays.

3.	 On the Child Care screen, check the box for the Baby and click Start Child 
Care. Baby will not require care until Child Care ends. The status will change 
from Active to Child Care.
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4.	 When you want to stop Child Care, click End Child Care. Baby will resume 
the simulation and the status will change from Child Care to Active.

5.	 Click Back to close the Child Care screen.

Printing Baby Birth Certificates
The Baby Birth Certificates - Summary screen allows you to print birth 
certificates on a host computer printer. This template can be printed or 
photocopied and birth certificate data for each participant can be printed 
from the All or Available Babies screens in the software.

1.	 On the All or Available Babies screen, click the Baby’s checkbox and 
click Birth Certificates. The Baby 
Birth Certificates – Summary                      
screen displays

2.	 Click Print Birth Certificates. The 
print popup displays.

Generating Reports
Control Center Software enables users to generate two types of reports: 

1.	 Optional manual progress reports to monitor participants while the 
simulation is in progress. 

2.	 Final reports automatically created for each participant at the end                         
of the simulation. 

The instructions below explain how to generate reports during the simulation.

1.	 On the Active Babies screen, make 
sure the Comm icon for each Baby 
you want to generate a report for 
is green, indicating they are within 
communication range.

2.	 Click the checkboxes next to the 
Babies you want reports for.

3.	 Click Get Report. The software will search for each checked Baby, one at a 
time, and retrieve the simulation report.

The Status column will change briefly to read Get Report. Then it will read 
Report OK if the command was successful or Report Fail if the command failed.

Generating Reports continues on the next page –>
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After the Simulation
The Report menus allow you to edit, view, export, and print student reports. 
You can edit the class, student, or Baby name. You can also add your own 
comments to the reports. When you open the Control Center software for 
the first time, there is only one report folder in the report database, called No 
Class.  Simulation reports are added to a report folder by entering the report 
folder name when programming Baby for a simulation.

Adding a Report Folder
1.	 On the All Babies screen, click Add in the Reports menu. The Add Report 

Folder popup displays.

2.	 Enter the new folder name into the text field and click OK to save the folder 
name. The new folder name displays on the report list with the number of 
reports in the folder.

NOTE: The No Class folder cannot be renamed or deleted.

The simulation report is in the folder that Baby’s reports have been assigned 
to. Each new download of a report for that Baby during the same simulation 
will overwrite the old report automatically and store it in the same location. 
When the simulation is over and Baby is brought within range of the 
computer, the software automatically retrieves the final simulation data and 
overwrites the older report.

Editing Report Folders
You can rename report folders, empty reports 
to the trash folder, or delete a single report. 
Click the pencil icon in the Reports menu The 
Report Folder screen displays.

Renaming a Folder
1.	 Click the checkbox for the folder you 

want to rename and click Rename. The 
Name Folder popup appears.
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Emptying a Folder
Folders must be empty before they can be deleted. Click the checkbox for the 
folder you want to empty and click Empty. All reports in the selected folder 
are moved to the Trash.

Deleting a Folder
A folder cannot be deleted if it contains any student reports. To delete a folder, 
click the folder checkbox on the folders list and click Delete. The selected 
report folder is erased from the software.

Selecting the Report Language
Reports can be viewed and printed in another supported language, regardless 
of the language you use on your computer.

1.	 From the class folder, click the checkbox for a report and click Language. A 
list of languages will appear.

2.	 Click the language you want to use for viewing and printing reports. All 
reports will display and print in this language until you change it.

Using Reports
Reports in the Report menu can be viewed, edited, printed, moved to a 
different folder, or deleted.

Viewing a Report
1.	 Click the report folder name that contains the report(s) you want to see and 

click the checkbox for the report(s).

2.	 Enter the new folder name into the text field. This can be up to 20 letters, 
numbers, and spaces.

3.	 Click OK to save the new folder name. The new name displays on the report 
list with the number of reports in the folder.

Viewing a Report continues on the next page –>
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Additional Report Features
•	 Baby contains sensors that read its internal temperature. On the second 

page of the report, you can view the temperature range that Baby was in.
•	 Baby can detect the clothing it wears. This can be used with the 

temperature readings to determine if Baby was clothed appropriately for 
the environment. You can find this chart on the second page of the report.

•	 If you installed a car seat detection kit, you can see how long Baby was in a 
car seat on the second page of the report.

•	 RealCare Baby 4 tracks the time it spends on its tummy. You can see this 
information on the second page of the report.

•	 RealCare Baby 4 tracks how much time the participant spent talking to 
Baby. You can see this information on the second page of the report.

Editing Reports
The class, student, Baby name, grading rubric, and comments can be changed 
on reports.

Changing Class Folder
The report you are viewing can be moved to another report folder, but a new 
report folder cannot be created.

1.	 On the Report screen, click the pencil icon next to Class. The List Selection 
popup displays.

2.	 Click on the folder you want to move the report to and click OK to save the 
report to that folder.

2.	 Click View. The first selected report will display.

3.	 Click Previous and Next to switch between reports.

4.	 Click Back or Done to exit the Report screen.
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Changing the Student Name
1.	 Click the pencil icon next to Student. The Edit Student popup displays.

2.	 Enter the new student name and click OK to save the new name.

Changing the Baby Name
1.	 Click the pencil icon next to Baby. The Edit Baby Name popup displays.

2.	 Enter the Baby name and click OK to save the new name.

Editing the Mishandle Rubric
1.	 Click [Edit Rubric]. The Edit Mishandle Rubric popup displays.

2.	 Adjust each mishandle percentage by clicking the arrows next to them and 
click OK to save the information.

NOTICE: Changing the mishandle rubric will update all reports in the software, 
both old and new.

Editing Other Grade Adjustment
1.	 Click the pencil icon next to Other on the 

Mishandle table. The Edit Other Grade 
Adjustment popup displays. 

2.	 Click the Adjust Grade By arrows to edit the grade and click OK to save                 
the changes.

NOTICE: Changing the Edit Other Grade Adjustment only updates the report 
currently displayed on the screen.

Adding Comments
1.	 Click the pencil icon next to Comments. The Edit 

Comments popup displays.

2.	 Enter your comments in the text field and click OK to save.



22

REALCARE BABY® 4 

Printing a Report
1.	 Open the report folder containing the report you want to print and click the 

report’s checkbox. More than one can be selected. 

2.	 Click Print. The Print Reports - 
Summary screen displays.

3.	 Click Print on the Print Reports - Summary screen. The Print popup displays.

Deleting a Report
1.	 Open the folder containing the report you want to delete and click the 

report’s checkbox.

2.	 Click Delete. The report moves to the Trash folder.

NOTICE: Reports deleted from the Trash folder are permanently deleted from 
the software.

Moving a Report to a Different Folder
1.	 Open the folder containing the report your want to move and click the 

report’s checkbox.

2.	 Click Move. The report folder list displays.

3.	 Select the folder you want to move the report to or click New Folder to 
move it to a new folder.

a.	 If you click New Folder, the Add Report Folder popup displays. Enter the 
new folder name and click OK.
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Exporting a Report
This option saves a copy of the report you are actively viewing to the 
computer clipboard as an image file. You can paste this file into many 
applications, including email, word processing programs, and photo editing 
programs. Only one report can be exported at a time.

1.	 Click on the report folder containing the 
reports you want to export and click the                          
reports’ checkboxes.

2.	 Click View. The selected report(s) will display.

3.	 Click File and hover over Export. 

4.	 Select Copy to Clipboard from the options that display. The viewed report 
is now copied as an image file to your computer’s clipboard and can be 
pasted into an email or word processing document.

NOTE: If your word processing program, email, or other software program 
has difficulty pasting the report image into a document, close and reopen 
that program and try copying the report to your clipboard in Control 
Center again. Text-based programs, like word processing, email, etc., give 
preference to text on the clipboard, not images. This may cause the program 
to paste any previously copied text rather than your report image. Closing 
and opening the program resets the clipboard, allowing you to copy                                                         
and paste your report image.

Maintenance
The Maintenance screen allows you to locate an Available Baby that is 
within communication range and perform diagnostics and testing. On the 
All Babies screen or Available Babies screen, click on the checkbox for each 
Baby that requires maintenance and click Maintenance. This opens the 
Maintenance screen.
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Troubleshooting Baby
1.	 Click the checkbox for the Baby you want to troubleshoot and click Start 

Test. Baby will chime when it is ready for testing. Baby’s status will change 
from Available to Diag.

2.	 Refer to the table on the next page for instructions and Baby’s response to 
actions. Baby will coo if all tests are passed. A green check displays below 
each symbol when that test is successful.

3.	 Click Stop Test and Baby will chime. That Baby’s status will                             
display Available.

Locating a Baby
Click the checkbox for the Baby you want to locate and click Page.                        
Baby will coo.

Troubleshooting
Use the Troubleshooting screen if you want to check that your Baby is 
functioning normally. On the Maintenance screen, click the checkbox for the 
Baby that you want to troubleshoot and click Troubleshooting. This opens 
the Troubleshooting screen.
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Test Function Action Needed by Tester Baby 
Response

Test 
Symbol

Battery None (automatic) None

Memory None (automatic) Coo CS

Movement                 Move Baby Cough Mov

Feeding sensor Bring bottle to Baby’s mouth Chime Btl

Neck forward Tilt Baby’s head forward Whimper Nf

Neck backward Tilt Baby’s head backward 2 whimpers Nb

Rough handling Strike Baby on its right side just above the hip 3 whimpers RH

Yellow diaper Place yellow diaper on Baby Chime Yel

Green diaper Place green diaper on Baby Chime Grn

Student ID Ensure ID is powered on and in range Chime ID

E-stop Push recessed E-stop button on Baby’s back Chime ES

Temperature None (automatic) None Temp

Outfit top Place outfit sensor close to Baby’s                 
belly button Chime OT

Outfit bottom Place outfit sensor close to Baby’s                   
belly button Chime OB

Bodysuit Place bodysuit sensor close the Baby’s             
belly button Chime Bd

Outerwear 
(optional)

Place outerwear sensor close the Baby’s       
belly button Chime Ow

Sleeper Place sleeper sensor close to Baby’s              
belly button Chime Sl

Car seat Place Baby into car seat Chime Cs

Microphone None (automatic - Baby makes a                 
buzzing sound) Laugh Mic

All tests pass None (automatic) Coo Pass
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Connectivity and Communication Troubleshooting
RealCare Baby 4 uses wireless programming to communicate with Control 
Center on your computer and the RealCare Baby Guide app on students’ 
devices. Wireless programming is a means by which two devices wirelessly 
communicate with each other. Wireless programming devices must always be 
paired, allowing the two devices to exchange data. 

RealCare Baby 4 always has wireless programming activated, but computers, 
laptops, tablets, and phones may not. When you open Control Center, verify 
that the wireless programming icon in the lower right corner of the screen is 
green      . If it is red, wireless programming is not activated on your computer. 
If the icon is yellow, then a Baby is currently communicating with Control 
Center. The red communication icon        only applies to RealCare Baby 3 and 
older. If you only have RealCare Baby 4, this icon will always be red. 

NOTE: RealCare Baby 3 still needs the communication adaptor plugged into 
your computer.

Several factors may weaken the wireless programming signal, including 
distance, humidity, and what it communicates through, such as wood, 
concrete, or metal. Bringing Babies closer to the computer will strengthen             
the signal.

Accessing and Changing Wireless Programming Settings All 
Platforms
General – Applies to all OS
1.	 Go to Settings on your computer or device and open the Bluetooth section

2.	 Tap the switch next to “Bluetooth” to toggle it on and off.

MacOS
1.	 Find and click System Settings (standard gear icon).

2.	 Click Bluetooth and click the switch next to “Bluetooth” to toggle it on 
and off. The Bluetooth icon at the top of your screen should light up when 
Bluetooth is on.
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Baby Will Not Add to Control Center
Baby Does Not Appear on the Add Baby Screen
Verify the following:

1.	 Control Center version must be 5.0 or above. 

Click Help > About to locate the version. Click Help > Check for Updates 
to see the Software Updates download page or follow this link: 
www.realityworks.com/knowledge-base/realcare-baby-control-center

2.	 Wireless programming is activated.

If the wireless programming icon in the lower right corner of the screen is 
red, then wireless programming is not activated on your computer. Try:

•	 Verifying if your IT department allows wireless programming devices to 
connect to your computer

•	 Activating wireless programming and trying it again

Windows 10
1.	 Click the Windows key > Settings (gear icon) > Devices. 

2.	 In Devices, select Bluetooth and Other Devices. 

NOTE: It may go to “Bluetooth and other devices” by default.

3.	 Click the switch next to “Bluetooth” to toggle it on and off.

Windows 11
1.	 Click the Windows key > Settings (gear icon) > Devices.

2.	 Click Bluetooth & Devices located on the right side of the screen.

3.	 Tap the switch next to “Bluetooth” to toggle it on and off.

IOS (iPhone and iPad)
1.	 Open the Settings app and tap Bluetooth.

2.	 Tap the switch next to “Bluetooth” to toggle it on and off.

Android (Phone and Tablet)
1.	 Swipe down on any screen and tap Bluetooth.

2.	 Tap the switch next to “Bluetooth” to toggle it on and off.

Baby Does Not Appear on the Add Baby Screen continues on the next page –>
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3.	 Yellow light on Baby is solid.

If not, press and hold Baby’s recessed button for 2 chimes, then release. Did 
a solid yellow light glow? If not, try it again.

4.	 Signal is strong.

If not, move Baby closer to your computer. Baby should be within 15 
feet of your computer and there should not be any obstructions, such as 
walls, between it and the computer. Metal desks or risers can also cause 
interference.

If you have verified all the above and Baby still won’t appear on the Add 
screen, contact Product Support.

Baby Appears on the Add Baby screen, but its Status is                         
Stuck on “Pending” 
Verify the following:

1.	 You Have Selected “Allow” or “OK” on any and all popups. 

If you are not sure, then restart Control Center and go back into the Add 
screen. Check the yellow light on Baby. If it is still solid, you do not need 
to start over. It is recommended that you close or minimize any other 
applications, as popups sometimes hide behind them.

2.	 Yellow light is still solid.

If not, press and hold Baby’s recessed button for 2 chimes.

3.	 Your computer thinks Baby is paired.  

If it thinks Baby is already paired, close Control Center. Go to Bluetooth 
Devices on your system, remove Baby, and restart the pairing process.

4.	 Previous steps did not work. 

If none of the steps above worked, remove Baby’s back cover. Press and 
hold the black button below the charging port for 5 seconds. Repeat the 
Add Baby instructions.

If Baby’s status is still stuck on “Pending”, contact Product Support.
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Baby Does Not Coo in Response to the Page Command
1.	 Verify Baby has a charge.

The red light on Baby should either be solid or blinking. If not, plug Baby 
into a charger.

2.	 Verify Control Center is getting a good signal from Baby.

Move Baby closer to your computer (within 15 feet and without 
obstructions, such as a wall). 

3.	 Delete and re-add Baby to Control Center.

This is required if Baby was added to a different computer previously.

4.	 Try sending commands to only 5 Babies at a time. This includes starting/
stopping a simulation, demo, troubleshooting tests, or getting reports. 

If none of the above actions work, contact Product Support.

Baby is Added, but Communications are Failing
Try locating Baby by clicking Page in Control Center.

Baby Does Coo in Response to the Page Command
1.	 Verify Baby is close to your computer (within 15 feet).

2.	 It is possible larger commands are failing because of a non-ideal radio 
environment, such as:

•	 Metal desks, walls, or structures (these can prevent wireless 
programming signals from traveling efficiently)

•	 A large number of wireless programming devices are in the area (this 
can cause interference)

Try moving to another room or area.

3.	 If you are using 20 or more RealCare Baby 4 simulators at once, only send 
commands to 5 or less at one time to prevent failures.

If none of the above actions work, contact Product Support.
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Baby Will Not Respond to Student ID
Determine if the Student ID is powered on. Press the RealCare logo on the ID. If 
you do not see a blue light flash, the ID is off

Student ID is Off
1.	 Firmly press and hold the RealCare logo on the Student ID for 10 seconds 

or until the blue light appears.  The Student ID will stay on for 8 days. This 
resets each time the Student ID is pressed.

2.	 Verify that the bottom cover is tightened.

3.	 Replace the battery (CR2032). 

If the Student ID does not power on after these steps, the ID is likely damaged 
and needs to be replaced. Contact Product Support for assistance.

Student ID is On 
1.	 Verify on the RealCare Baby Guide app that the 12 characters on the face 

of the physical Student ID matches the programmed one. If these do not 
match, then the Student ID was either mistyped when programming Baby 
or it was switched. 

2.	 Verify Control Center can detect the Student ID in the Beacons screen. To 
access the Beacons screen, click File > Beacons. 

3.	 If the previous steps do not fix the issue and the Student ID powers on, 
replace the battery (CR2032). Then, power on the ID and try again.

If replacing the battery does not fix the Student ID, the ID is likely damaged 
and needs to be replaced. Contact Product Support for a replacement if still 
under warranty.

Baby Will Not Connect to RealCare Baby Guide App
Baby is Not Programmed 
Baby must be programmed for a simulation with a Ready or Active status for it 
to pair with the RealCare Baby Guide app.
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Baby is Programmed
1.	 Click OK on any system popups, allowing Baby to communicate                       

with the device.

2.	 Verify Baby is close to device (within 15 feet).

3.	 If you are not using a QR code, verify you are trying to connect to the 
correct Baby by identifying Baby via its wristband. 

If you are using are using a QR code, verify the QR code is for the correct 
baby. When you scan the QR code, the Baby’s name displays.

4.	 If another student accidentally paired the wrong Baby to their device, you 
must restart the simulation and connect the Baby with the correct student’s 
device. Alternatively, you can hold Baby’s recessed button for 2 chimes and 
connect the desired student device to Baby. 

NOTE: This can only happen while Baby is in range, specifically still in the 
classroom. The RealCare Baby Guide app only allows a Baby to pair to one 
device per simulation. 

5.	 Verify the device supports Bluetooth 4.0 or later.

Go to Bluetooth settings and delete any known Babies from the device and 
try connecting Baby again. 

6.	 If you are using a device that is monitored by your IT department, 
verify that there are not any restrictions on connecting to wireless             
programming devices. 

NOTE: Once a simulation stops, the Baby is no longer paired with the 
student’s device. Each time Baby is programmed with a new simulation, 
you must re-pair the Baby with the device.

Baby Will Not Refresh Status on the RealCare Baby Guide App
1.	 Verify Baby still has a charge. The red light on Baby’s back should be solid or 

flashing. If the red light is off, then the batteries are dead.

2.	 Verify Baby is close to the device (within 5 feet).

3.	 Verify Baby is still in the simulation it was in when paired to the app.

Baby Will Not Refresh Status on the RealCare Baby Guide App continues on the next page –>
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4.	 Verify that the correct Baby was paired. If the wrong Baby was paired, you 
must restart the simulation and connect the Baby with the correct student’s 
device. Alternatively, you can hold Baby’s recessed button for 2 chimes and 
connect the desired student device to Baby.

REALCARE BABY® 4 

Baby Will Not Respond to Toy
1.	 Verify that Baby is in a demo or simulation. 

2.	 Verify that there is a Student ID powered on near Baby. Quickly press the 
RealCare logo on the ID. A blue light should flash 1-3 times.

3.	 Verify that the Toy is on. A red light on the face of the Toy should be on. 

NOTE: The toy will automatically power off after 30 seconds of no motion.

4.	 If the Toy does not power on when you press the button, inspect and 
replace the batteries.

If the Toy still does not power on, it is likely damaged and will need to be 
replaced. Contact Product Support.

NOTE: If you are short a Toy, you can program Baby with schedules 1-15. 
Those schedules do not contain a Play Care Event.

Baby Will Not Babble or Report Talk Time 
NOTE: Baby will only babble when awake. Talk time should be tracked 
throughout the simulation, except during care events.

1.	 Verify that Baby is programmed. Its status should be Ready or Active

2.	 Verify that Baby still has a charge. The red light on Baby’s back should be 
solid or flashing. If the red light is off, then the batteries are dead.

3.	 Verify that Baby’s microphone is working properly by running the 
Troubleshooting test. If Baby is still in a simulation, you must stop it before 
running a troubleshooting test. Start the troubleshooting test and you will 
soon hear a buzz sound followed by a giggle. The test symbol, Mic, will now 
have a checkmark, indicating the microphone is working. 

If the microphone fails the troubleshooting test, contact Product Support.

NOTE: You can still use a Baby with a broken microphone. However, it will 
not babble when awake or report talk times.
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Baby Will Not Respond to Loud Noises 
1.	 Verify Baby is in a simulation.

2.	 Verify the red light on Baby’s back is still on. If the red light is off, Baby’s 
batteries are dead, and the simulation has had a Battery Shutdown.

3.	 Verify loud noise detection with a power tool, speaker, fan, or any other 
sound source that can be placed close to Baby’s chest. If Baby does not 
detect a loud noise, run a troubleshooting test on Baby’s microphone.

NOTE: Baby’s loud noise threshold is set to 95 dB for 1 full second only a 
few inches from Baby’s chest.

Checking for Updates
1.	 Click Help and click Check for Updates in the list that displays.

2.	 Make sure your Internet connection is active. A web browser window 
will open, and a message telling you if any updates are available for your 
version of Control Center software or Baby will appear.

Downloading and installing software updates
1.	 Click the download button for the Control Center software update. A 

window will appear containing instructions on how to complete the 
update download and installation.

2.	 Download the update installer file to your hard drive.

3.	 Open or run the downloaded file to start the update installation.

4.	 Follow the on-screen instructions to complete the installation.

5.	 A software update may or may not include a Baby update. If Babies show 
a green checkmark and an asterisk in the Comm column, they have a 
software update available. See Updating Babies.

Getting Control Center Software                                
and Baby Updates
Software updates for both Control Center and Babies can be retrieved via an 
Internet connection.
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Updating Babies
Updates will become available via the Realityworks website. If Babies show a 
green communication icon with an asterisk in the Comm column, they have a 
software update available.

1.	 Connect all Babies to a charger.

2.	 From the All Babies screen, click the checkboxes for each Baby with an 
update available icon (green check with an asterisk) in the Comm column 
and click Maintenance.

3.	 Click Update Babies. An instruction popup appears.

NOTE: Rarely, the software indicates that Baby requires a factory update. If 
that happens, contact Product Support.

4.	 Click OK in the instruction popup. A popup appears showing the status of 
each Baby’s update.

An updated Baby’s status changes to Updating: Done. The update process 
continues until every selected Baby is updated. Babies that temporarily fail are 
retried until successful. 

You can start and stop the update process as much as you want. No harm will 
come from cancelling or interrupting Baby updates. 

After updating reaches 100 percent, Baby will go offline while updates are 
applied. Once it comes back online, the Comm icon will be green again but 
with no asterisk.

NOTE: Each Baby could take over 35 minutes to update. Large numbers of 
Babies can take a very long time to update. You may need to review your 
computer’s standby and hibernate settings.

Calibrating Battery
Weak batteries take less time to fully discharge starting from a full charge. 
Calibrate Battery checks Baby’s battery module in a fast discharge mode and 
compares the discharge time to normal batteries.
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Fully Charging Baby
1.	 Connect Baby to the charger. The green charge light on Baby’s back turns 

on, solid.

2.	 Wait up to 6 hours for Baby’s green charge light to turn off. Baby’s batteries 
now have a full charge.

3.	 Unplug Baby from the charger.

Reading Calibrate Battery Result
1.	 Calibrate Battery completely discharges Baby’s battery, so plug Baby                    

into the charger.

2.	 On the Maintenance screen, hover over Baby’s battery icon.

3.	 Read the result at the bottom of the window.

NOTE: Check the calibration results immediately after plugging Baby back into 
the charger for an accurate reading.

Calibrating Battery
1.	 Fully charge Baby and unplug them from the charger.

2.	 On the Maintenance screen, click Calibrate Battery. An instruction            
popup appears.

NOTICE: You will not be able to use Baby until the calibration is complete.

3.	 Click OK to check Baby’s battery module. The Status column changes 
to Calibrate--. Baby’s status stays in Calibrate—until the batteries are 
completely discharged (up to 20 hours). The Comm icon changes to red.

4.	 Plug Baby into a charger. Baby’s status automatically returns to Available 
when Calibrate Battery finishes. Once Baby is plugged back in, it 
communicates and returns to Available.

NOTICE: Fully charge Baby.
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Deleting a Baby from the Baby List
1.	 Click the Baby’s checkbox and click Edit on the Control Center toolbar.

2.	 Click Delete Babies on the dropdown menu. The Caution popup displays.

3.	 Click Yes to delete this Baby from the software.

Uninstalling Control Center Software
If necessary, Control Center software can be removed from the host computer. 
To prevent damage to the operating system, always follow the procedure 
below. If problems occur when removing the software, contact Realityworks 
Product Support (800.830.1416) before proceeding.

Windows
1.	 Click the Windows Start > Control Panel.

2.	 Click Programs and Features and select Baby Control Center.

3.	 Click Uninstall.

Macintosh
1.	 Go to the Baby Control Center software folder and open the _uninst folder.

2.	 Double-click uninstaller.command and follow the on-screen instructions.
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End User License Agreement
Subscription and License Agreement
By clicking the “accept” button and using this software, you agree to 
become bound by the terms of this Subscription and License Agreement 
(“Agreement”). If you do not agree to these terms, click on “decline” and, if 
you are downloading this software from a CD ROM, promptly return it to your 
vendor. READ THE FOLLOWING USE CONDITIONS AND DISCLAIMERS IN THIS 
AGREEMENT CAREFULLY BEFORE INDICATING YOUR ACCEPTANCE. In this 
Agreement, the term “you” refers to: (i) an individual purchasing a RealCare® 
Control Center subscription, as agent for a corporation, organization or other 
entity; or (ii) an individual consenting to this Agreement as a condition of 
using a RealCare® Control Center through a subscription purchased by a 
school or other institution (“Institution”), where the individual is employed by, 
a student or parent of a student at, or otherwise affiliated with the Institution.

REALCARE® CONTROL CENTER Subscription and License Agreement 

LICENSE. Realityworks, Inc., in consideration of payment of the applicable 
subscription fee and acceptance of this Agreement, grants you a non-
exclusive, transferable license and right to use and access the RealCare® 
Control Center subscription (the “Licensed Materials”). This subscription 
permits access and use of the Licensed Materials by loading the software on a 
computer(s). 

OWNERSHIP. The Licensed Materials, including without limitation all copyrights 
and other intellectual property rights therein, are the sole and exclusive 
property of Realityworks (or its parents, subsidiaries, affiliates, or designers) or 
its suppliers. By indicating that you accept these terms, you do not become 
the owner of the Licensed Materials, but are entitled to use them according to 
the terms of this Agreement. 

PROHIBITED USES: Except as expressly permitted in this Agreement, any 
copying, distribution or modification of the Licensed Materials is strictly 
prohibited. No part of the Licensed Materials may be copied for resale or 
other commercial use, or posted on public bulletin boards, web sites, Internet 
domains, or online chat rooms. No part of the Licensed Materials may be 
reverse engineered or included in other software.  
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LIMITED WARRANTY. This software is warranted by Realityworks, Inc. to be 
free from defects for two years following acceptance of the terms of this 
License Agreement. Realityworks, Inc. will replace at its expense any defective 
software returned to it during the warranty period. EXCEPT AS SET FORTH 
IN THE FOREGOING SENTENCE, REALITYWORKS MAKES NO WARRANTY OR 
REPRESENTATION, EXPRESSED OR IMPLIED, WITH RESPECT TO THE LICENSED 
MATERIALS, WHICH ARE LICENSED “AS IS”. ALL OTHER WARRANTIES ARE 
EXPRESSLY EXCLUDED AND DISCLAIMED, INCLUDING WITHOUT LIMITATION 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE, AND ANY WARRANTIES ARISING BY STATUTE OR OTHERWISE IN 
LAW OR FROM COURSE OF DEALING, COURSE OF PERFORMANCE, OR USE 
OF TRADE. ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER 
PERSON OR ENTITY ARE VOID. YOU ASSUME ALL RISK AS TO THE QUALITY, 
FUNCTION, PERFORMANCE, AND ACCURACY OF THE LICENSED MATERIALS. 

LIMITATION OF LIABILITY. IN NO EVENT WILL REALITYWORKS OR ANY 
OTHER PARTY WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, 
PROMOTION OR MARKETING OF THE LICENSED MATERIALS BE LIABLE TO 
YOU OR ANY OTHER PARTY FOR ANY SPECIAL, INDIRECT, INCIDENTAL, 
RELIANCE, EXEMPLARY, OR CONSEQUENTIAL DAMAGES, INCLUDING LOSS 
OF DATA OR PROFITS, OR FOR INABILITY TO USE THE LICENSED MATERIALS, 
EVEN IF REALITYWORKS OR SUCH OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL REALITYWORKS OR 
SUCH OTHER PARTY’S LIABILITY FOR ANY DAMAGES OR LOSS TO YOU OR ANY 
OTHER PARTY EXCEED THE LICENSE FEE PAID FOR THE LICENSED MATERIALS. 

GENERAL. If any provision of this Agreement is determined to be invalid or 
unenforceable under any applicable law, it shall be deemed omitted and the 
remaining provisions shall continue in full force and effect. This Agreement 
may be modified only in writing authorized by Realityworks. Realityworks’ 
waiver of any right shall not constitute a waiver of that or any other right in 
the future. This Agreement shall be governed by and construed in accordance 
with the laws and in the state and federal courts of the State of Wisconsin. 

This Agreement constitutes the entire understanding between the parties 
with respect to the subject matter hereof, and all prior agreements, 
representations, statements, and undertakings, oral or written, are hereby 
expressly superseded and canceled.

REALCARE BABY® 4 
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Additional help and information
Online Product Support 
We’re here to help! Our online Product Support features video 
tutorials, downloadable documents, frequently asked questions, and 
product notices, all of which make it easy for you to get support for 
products, software and more, day or night. Find our online product 
support area here: www.realityworks.com/knowledge-base

Online Store 
Supplies, accessories, select simulators, curricula, and more are 
available for purchase from our online store 24 hours a day!  
Find our online store here: www.realityworks.com


